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Problems with our UART implementation

/* Infinite loop */
while (1) {

= Remember the final solution:| ™ Gsasr ox @aeto, vsare s @azzo)) ;

}
O This solution is a blocking implementation since

USART_Rx will not return until data is received

O Better solution to call USART _Rx function only if a
character can be found in the buffer

O An other good way to use interrupt

= Better to start a new project in the same way
done before

= See the following sides to remember stating a
new project
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

==+ New Silicon Labs Project O X
Project setup ﬁ
Select the board, part, and SDK for the project.
Boards:
Search ‘ b4

EFM32 Giant Gecko Starter Kit board (BRD2200A Rev A03) *

Part;

‘ Search ‘ W

| EFM32GG990F1024 |

SDK:
‘Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel V| (7]

Manage SDKs...

@ < Back Finish Cancel

..... - Méréstechnika és .
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

== New Silicon Labs Project O X
Project setup @
Select the board, part, and SDK for the project.
Boards:
Search | w

EFM32 Giant Gecko Starter Kit board (BRD2200A Rev A03) *

Part:

| Search | W

| EFM32GG990F1024 |

SDK:

|Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel

Manage SDKs...

@ < Back Finish Cancel

© BME-MIT 2020

«= New Silicon Labs Project O X
Project setup E
Select the type of project.
Project Type:

@ Empty C Program - Create an empty C executable project.

(O Empty C++ Program - Create an empty C++ executable project.
(O Example - Create a working example for the part.

(O Library - Create an empty static library project.

(O Simplicity Configurator Program - Create a project whose contents are driven from
Simplicity Configurator.

@ < Back Finish Cancel
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Strating with a new project

= Give project name and location, and set
Copy content:

«== New Silicon Labs Project O X
Project Configuration @
Select the project name and location,

Project name: | UART_COM ‘

Use default location
CA\Users\krebesz\SimplicityStudic\v4_workspace\UART_COM Browse...
With project files:
() Link to sources
(O Link sdk and copy project sources
(@ Copy contents

@ < Back Mext = Cancel

..... - Méréstechnika és .
© BME-MIT 2020 rl'l.l} Informaciés Rendszerek 5.slide

Tanszék



Project created — start programming

= Main.c can be also renamed to UART_COM.c

= Although an empty C project has been created a
program skeleton is offered automaticly

[t5 Project Explorer 2 F % ¥ = O || [ UART_COM.c &
== STK3700_blink [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - ( 1 #include "Em_dEViCE -h"
(25 STK3700_button [GNU ARM v7.2.1 - Debug] [EFM32GG990F 1024 é #include "em chip.h"
~ 5 UART_COM [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gec|| -~ _ _
: 4=int main (veoid)
kit Includes 5 1
= CMSIS 6 /* Chip errata */
= emlib 7 CHIP Init():
W [= SIC g
lel UART_COM.c G /* Infinite loop */
10 while (1) {
11 }
12 }

ALk
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Files to be added to the project

= Search the library where Simplicity Studio is
installed

O Contains include (inc: *.c) and source (src: *.h) files:
i:\Simplicity_studio\developer\sdks\gecko sdk_suite\v2.6\platform\emlib\

* Following files have to be drag-and-dropped into
emlib library of the project (see next slide):
0 em_cmu.c (clock management unit)
O em_gpio.cC
O em_usart.c
O em_core.cC

O em_emu.c (energy management unit)
© BME-MIT 2020 I'hj_l' E%fit:ccig:i;aeﬁ;szerek 7.slide




Files to be added to the project

= Furthermore they have to be included into the

program:

L Project Explorer & =% ¥ = 0| [¢ *UAR] COM.c [ em_device.h

(5 STK3700_blink [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gecko SD
5 STK3700_button [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gecko 9
(5 UART_COM [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gecko SDK 9
v =% UART_COM_Development [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024
ki Includes
= CMSIS

( ~ & emlib N

1, L€ em_cmu.c

N [£ em_core.c
i L] em_emu.c
i lg em_gpio.c
le| em_system.c
€ em_usart.c)
w [=F SIC

L€ UART _DEV_COM.c

(26 VIARYT Piem et TR ADIRA .7 7 A Mkl o=T MIFPR AT mAmnr4mnT A el O

© BME-MIT 2020

#include "em device.h" "\
#include "em chip.h"
#include "em cmu.h"
#include "em gpio.h"
#include "em usart.h"
#include "em core.h"
#include "em emu.h" 4)

J!':J [T Y PR T I e I S

‘=int main(void)

{
/* Chip errata */
CHIP Init();

/* Infinite loop */
while (1) |
}

- Méréstechnika és .
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Code to start with

Use the following code as a reference for your work (continue from previous result):

#include "em_device.h"
#include "em_chip.h"
#include "em_cmu.h"
#include "em_gpio.h"
#include "em_usart.h"
#include "em_core.h"
#include "em_emu.h"

int main(void)
{

/* Chip errata */
CHIP_Init();

// Enable clock for GP1O
CMU->HFPERCLKENO |= CMU_HFPERCLKENO_GPIO;

// Set PF7 to high
GPIO_PinModeSet(gpioPortF, 7, gpioModePushPull, 1);

// Configure UARTO
// (Now use the "emlib" functions whenever possible.)

// Enable clock for UARTO
CMU_ClockEnable(cmuClock_UARTO, true);

// Initialize UARTO (115200 Baud, 8N1 frame format)

// To initialize the UARTO, we need a structure to hold

// configuration data. It is a good practice to initialize it with

// default values, then set individual parameters only where needed.
USART _InitAsync_TypeDef UARTO init = USART_INITASYNC_DEFAULT;

USART_InitAsync(UARTO, &UARTO_init);
// USARTO: see in efm32ggf1024.h

// Set TX (PEQ) and RX (PE1) pins as push-pull output and input resp.
// DOUT for TX is 1, as it is the idle state for UART communication
GPIO_PinModeSet(gpioPortE, 0, gpioModePushPull, 1);

// DOUT for RX is 0, as DOUT can enable a glitch filter for inputs,

// and we are fine without such a filter
GPIO_PinModeSet(gpioPortE, 1, gpioModelnput, 0);

// Use PEO as TX and PE1 as RX (Location 1, see datasheet (not refman))
// Enable both RX and TX for routing

UARTO->ROUTE |= UART_ROUTE_LOCATION_LOC1;

// Select "Location 1" as the routing configuration

UARTO->ROUTE |= UART_ROUTE_TXPEN | UART_ROUTE_RXPEN;

/* Infinite loop */
while (1) {
}

}

© BME-MIT 2020
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Setting the terminal program

" Check UART (COM port number and its settings) in

Device Manager in Windows (now it is C9M4)

% Device Manager | s
File Action View Help
&= @ B B EXG

@ Carneras A
L Computer

== Disk drives

B8l Display adapters

- DOVD/CD-ROM drives

i Firmware

i Human Interface Devices

*= |DE ATA/ATAPI controllers

= Keyboards

[ | Memory technology devices

@ Mice and other pointing devices
3 Monitors
& Network adapters

Portable Devices
l v ? Ports (COM & LPT) »
@ JLink CDC UART Port (COM4)
= Print queues v

..... - Méréstechnika és .
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Setting the terminal program

= A PC-based terminal program is needed to get

access to COM4 port: an option is putty.exe

ER® PuTTY Configuration ? X ER® PuTTY Configuration ? X
Category: Category:
Em Basic options for your PuT TY session 5--S_ession Options controlling local serial lines
¢ Logging . i .- Logging .
& Terminal Spe?lfy_l‘he 2 tion you wantto connect to 3 o Terminal Select a serial line f )
~ Keyboard Serial line Speed - Keyboard Senal line io connectio |COM4 |
- Bell coms 115200 ) | - Bell
- Features e - Features Configure the seral line
=-Window i . . =-Window
. Appearance (JRaw () Telnet () Rlogin OSS)—' (@) Serial - Appearance Speed (baud) |‘I152EID |
- Behaviour Load. save or delete a stored session 1 - Behaviour Data bits |8 |
- Translation s d Sessi - Translation
- Selection aved Sessions [+-Selection s |‘I |
- Colours | | - Colours Parity N
—-C i - 5-C ari ane v
El “c.n.rgetc 1on Default Settings Load ‘;----Data on
aa — Flow control MNone v
- Proxy — - Proxy
- Telnet - Telnet ‘
- Rlogin - Rlogin \
Delete _/
. ele -SSH 5
. Serial T - Serial
4
Close window on exit
) Always () Never (@) Only on clean exit
About Help Cancel About Help I Open Il Cancel

6

© BME-MIT 2020 11.slide
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Non-blocking character reception

" Check our previous solution again
0 What does USART Rx do(stay on it by mouse pointer)?

/* Infinite loop */
while (1) {
USRRT_Tx{UERTU, USRRT_Rx{UERTD]];

\ } uintB_t USRRT Rx (USART TypeDef *usart)
{

while (! (usart->STATUS & USRRT STATUS RXDATAV)) {
}

blems 4 Search | 2* Call H

return (uintf t)usart->RXDATL;
am Cutput Console —

}

Press 'F2' for focus

O Operation: remains in while loop until in
USART_STATUS_ RXDATAV bit flips to 1, then returns

with the received character (RXDATA)

 See 03_EFM32_Reference_manual EFM32GG-reference_manual.pdf
on page 481 (and next slide)

o) Blocklng can be avoided if we check the STATUS reg

-1 w™e chnika
© BME-MIT 2020 I'I-uj- Informacios Rengszerek  12.slide
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Non-blocking character reception

17.5.5 USARTN_STATUS - USART Status Register

o0t0 |5 (g |a|a|n|ee|x|a|e|s|glee|slele ||y |z]e]o |~ fo|o|w|o|~]|-]|o
Reset coooolon—oooooc
Access || | o oo iy | ¥ K| X | x| e
}_
}_
5555—2 z L _ 185 lo|la
Name 7|z |2 2 P—mQDCOF—"ZZ
_I>ID: < }_l—_IUjL.IJu-'
Sl |5 |5 all (s X |@ < |xX X
S| E|m | o > |—><E|—ﬂ:
LS| X |x 14 [
X | Q|\F|F
T |
u
7 RXDATAV 0 R RX Data Valid

Set when data is available in the receive buffer. Cleared when the receive buffer is empty.

= Non-blocking solution: check STATUS reg. and call
USART_Rx() function only if incoming character is
available

T

MODEGCYETEM 1782

- Méréstechnika és .
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Non-blocking character reception

= Search em usart.h for a function that checks
STATUS register (if available, hopefully it is):

# Debug Adapters | 5% Outline i3 =L
®* USART_IntDisable(USART_TypeDef*, uint32_t) : voi
oS USART_IntEnable(USART_TypeDef*, uint32_t) : voic
e° USART_IntGet(USART_TypeDef®) : uint32_t

* @brief
J Get USART STATUS :egiste:.

* @param[in] usart
Pointer to USART/URRT peripheral register block.

* @return
STATUS register wvalue.

4444444444444444444444444444444444444444444444444444444444444

-~ STATIC INLINE uint32_t Srsggeleiatble s (USART TypeDef *usart)

{
return usart->STATUS;

..... - aré hnika é .
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Non-blocking character reception

= Application of USART StatusGet() function:

/* Infinite loop */
while (1) {

}

}

if (USART StatusGet (UART0) & USRRT STATUS EXDATAV) ({
USART Tx(UARTO, USART Rx(UARTO));

" Even more elegant solution if we implement an
own non-blocking function to receive characters

int USART RxNonblocking (USART TypeDef *usart)

{
int retval = -1;

if (usart->STATUS & USERT_STATUS_RXDATHV] {
retVal = (int) (usart->RXDATA) ;

}

return retVal;

int ch;
ch = USART RxNonblocking (UARTO) ;
if (ch !'= -1) {
USART Tx (UARTO, ch);
t

Implementation of non-blocking function
(put it before the main function)

© BME-MIT 2020

Application of non-blocking function
(put it in the main function)

- Méréstechnika és .
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Non-blocking character reception

= Remark on USART_Tx() function:
O If data to be sent is too much even USART_Tx()

function can be blocking — have a look at USART Tx()

/* Infinite loop */
while (1) {
//USRRT StatusGet (USART TypeDef *usart)
if (USRRT StatusGet (UARTO) & USART STETUS_RKDETR?] I

(VSIS (UARTO, USART_Rx (UARTO) ) ;
} void USART Tx(USART TypeDef *usart, uintB_t data)

- a7 ST i mnty */
! (usart->5TATUS & USART STATUS TXBL) ) j{ §

slems 4 S

n Output Cons|  usart->TXDATA = (uint32 t)data;
}

Press 'F2' for focus

O Clearly seen that blocking may happen but “less
severe” —> USART_STATUS_ TXBL bit is checked in
STATUS register

- Méréstechnika és
© BME-MIT 2020 Informacios Rendszerek
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Non-blocking character reception

O USART_STATU S_TXBL bit (TXBL may appear in other registers- be careful)

17.5.5 USARTNn_STATUS - USART Status Register

w10 |z (gsiglt|xlglelz|aldlsigleeslele|tley|c|2e]o o~ s |o|a|-|o
Reset o |lo|lo | oo lo olo|lol|lo | o
Access r | v | ol o« ¥ || | x|
'_
=T
- | =
50|z |x/2|Z _18|%|n e
Name =z |2 |8 5 |K T ok |Z2|3
T > |l |l © <L — I o | W
S| |w|a x & X M |g [ X | %
u.“':)()( o o
x | QIF |+
X |z
G TXBL 1 R TX Buffer Level

Indicates the level of the transmit buffer. If TXBIL is cleared

TXBL is set whenever the transmit buffer is half-full or empty.

TXBL is set whenever the transmit buffer is empty,hnd if TXBIL is set,

See 03_EFM32_Reference_manual _EFM32GG-reference_manual.pdf

© BME-MIT 2020

on page 481
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Non-blocking character reception

18]
et
1]
@
)
1]
e
Q
c
QL
=]

O Operation of data transmission:

e Generated data is loaded into TX
Register only if TX Register is empty

— Otherwise data in TX Register is
overwritten and data loss may occur

. !f TX.Buffer is empt.y data is loaded
into it from TX Register

e From TX Buffer data is sent out via
the communication line (UART)

e R=115200bps->1byte needs 70us
e T clk=1/14MHz=70ns->1000cycles

per byte!!l
TX Buffer to send data to comm. line I I I I

- Méréstechnika és .
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Interrupt-based character reception

" Problem with non-blocking character reception
O If the main program executes a long-lasting task before
repeated checking of character is done data loss may
occur

O To prevent that kind of data loss application of
interrupt can be a solution

Peripheral i Cortex- M3 NVIC

l SET ENA[n]'CLFE\IA[n] ‘
Active interrupt
Interrupt set clear IRQs + CFt>U t
condition IF[n] » = P interrup
| SETPENDI[n]/ CLRPEND[n]
|
Software generated interrupt

[ Fsnl [ Feml |f N || L

¥y
N

- Méréstechnika és .
© BME-MIT 2020 M Informaciés Rendszerek 19.slide
Tanszék




IT initialization for a peripheral

= |nitialization of IT in a general case:

O Enabling peripheral (turn perif. on, config., etc.)| | . ious ar init
O Determination of IT-handling function
C
O Clear of IT flag belonging to the certain IT 0
M
 An IT request may be stuck from a previous state that can E
cause problem since after enabling IT a false interrupt can | °
take action. A stuck IF can be the consequence of a non- N
initialized peripheral (e.g. IT occurs on a floating input) \(/)v
O Enabling the IT of a certain peripheral
0 Clearing of global IT flag (if needed) .
O Enabling of global IT :
R

NOTE: THIS SLIDE COMES FROM THE INTERRUPT TOPIC OF LECTURES
USE THAT LECTURE AS A REFERENCE IF NEEDED

- aré hnika é .
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Interrupt-based character reception
" Interrupt has to be enabled for UART

174 RegiSter Map gzgil;hg/lji;ieference_manuaI_EFM3ZGG-reference_manual.pdf

The offset register address is relative to the registers base address.

Ox040 USARTn_IF R Interrupt Flag Register
Ox044 USARTn_IFS WH Interrupt Flag Set Register
Ox048 USARTn_IFC Wi Interrupt Flag Clear Register
Ox04C [ USARTn_IEM ] RW Interrupt Enable Register

17.5.20 USARTN_IEN - Interrupt Enable Register

03 _EFM32_Reference_manual EFM32GG-reference_manual.pdf

See page 490
.
0x04C g g zlylge |zl g e r~elw|z|odlcl2 g @ ~ 0w < | ollal-]o
Reset ol|loco|lo|loc o | oc|loo | o|lacllollc | o
= |2 2|2 =2 222 |2 | 2)=):=2 |2
Access gl z z zlee|z|ellzle |

Er:lIu_u.u.u.—‘ﬁ
Name AERFE A AEACIERCIE (Y A
Ol st la FlRe|2|xXlalF|F

ey %

Se—

2 RXDATAV 0 RW RX Data Valid Interrupt Enable
"‘:=.-.

Enable interrupt on RX data. o)
= FYEET Tanszék
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Interrupt-based character reception

O Check em_usart.h for interrupt enable function

524 UpaTam[In] USarT
# No Adapters | E= Outline &2 -0 B25 Pointer to USART/UART peripheral register block.
LS o 8 7 826
+ USART_InitPrsTrigger(USART_TypeDef*, const USART ~ 827 * @param[in] flags
o ¥ USART_InitlrDA(const USART_InitirDA_TypeDef*) : v¢ 828 * }'SRRT;’L'P.R'I‘ :'_nter:upt source (s) t-:_) f?nab'_e. Use one or more valid
© ® USART IntClear(USART TypeDef*, uint32.1)  voic S D ag o e R e R I ) R o g ewxss.
o 3 USART_IntDisable(USART_TypeDef*, uint32_t) : void STATIC INLINE void (USART TypeDef *usart, uint32 t flags)
of USART _IntEnable(USART_TypeDef*, uint32_t) : void T - - -
® ¥ USART_IntGet(USART _TypeDef*) : uint32_t

ol USART_IntGetEnabled(USART_TypeDef#) : uint22_t

usart->IEN |= flags;

O Insert USART _IntEnable() function
flags = register content, here the 2" bit is interesting
(see previous slide)

e Check efm32_gg usart.h

#define USART_IEN_RXDATAV (Ox1UL << 2) /**< RX Data Valid Interrupt Enable */

e Code to be applied:

/ /USART IntEnable (USART TypeDef *usart, uint32 t flags)
L IUSI—LRT_Il’ltEnahlE(UI-LRTU USI—LRT_IEN_RXDI—LTI—HI]

; /* Infinite loop */
! while (1) {

..... - Méréstechnika és .
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Interrupt-based character reception

" |nterrupts have

to be cleared (all ITs) for UART

O Check em_usart.h for interrupt clear function

BH No Adapters | 5= Outline & = O

R e ¥ 787 % Pending USRERT/URRT interrupt source(s) to clear. Use one or more vall

+  USART_InitPrsTrigger(USART_TypeDef*, const USART ~
e 9 USART InitlrDA(const USART _InitlrDA_TypeDef*) : v

@ 5 USART _IntClear(USART _TypeDef*, uint32_t) : void

o ® USART IntDisable{USART_TypeDef*, uint32_t) : void

e ¥ USART IntEnable{USART TypeDef*, uint32_t) : void

of USART_IntGet(USART _TypeDef*) : uint32_t

e 9 USART IntGetEnabled (USART_ TypeDef*) : uint32_t

e 5 USART _IntSet(USART _TypeDef*, uint32_t) : void

@ % USART StatusGet(USART TypeDef*) : uint32

* @param[in] flags

1 & [

* interrupt flags for the USART module (USERT IF nnn) OR'ed together

S0=  STATIC INLINE void [giugee.i-al-They(USART TypeDef *usart, uint32_t flags)
791 {
792 #if defined (USART HAS SET CLEAR)
usart—>IF CLR = flags;
#else
usart[}IFC = flags; ]
#endif
797 '}

1
J [T 5 BT = %)

17.5.19 USARTN_IFC - Interrupt Flag Clear Register

o8 |53 |a|e|n|gelz|g|n]a]aeenelelz]efa]z]2]o|o|n]o/o]<]o|a]]o
Reset ol|lo|lo | oo o|loo oo o
Access |z 2 =2 2|22 2|2 =
TR I T s < A TR TR I T o

Mame olgs |l e |3 |6/2/2 (5
O lm | |w W x|x X X|0@L ﬁ

= |0wL |0 | |Fx ZE|x

o

03 EFM32 Reference manual EFM32GG-reference_manual.pdf See page 489
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Interrupt-based character reception

O All bits in USARTn_IFC register have to be cleared

e A define can be found in efm32gg usart.h for that purpose:
#define _USART IFC MASK OxO00001FFOUL /**< Mask for USART IFC */

O Insert USART _IntClear() function after UART init
O Code to be applied:

//USBRT IntClear (USART TypeDef *usart, uint32 t flags)
USERT IntClear (UBRTO, USART IFC MASK);

//USBRRT IntEnable (USART TypeDef *usart, uint32 t flags)

USART IntEnable (UART0, USRRT IEN RXDATRV);

/* Infinite loop */
while (1) {

O This step is precautious: it is very probable that the
program would work but in general, not clearing IT
flags can cause a trouble

- aré hnika é .
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Interrupt-based character reception

JUST DONE COMING NEXT

Peripheral N Cortex- M3 NVIC

BEOERE R EE

| SETENA[n)/ CLRENA[n] |

Active interrupt CPU
Interrupt set  clear IRQs R v interrupt
condition IF[n] i cet clear
| SETPEND[n]/ CLRPEND[n]

y

v
NS

Software generated interrupt

= So far UART peripheral-related IT has been dealt
with
= From now let’s see the core-related IT

- aré hnika é .
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Interrupt-based character reception

= Core-related IT— IT for the UART has to be enabled

0 em_decive.h + F3 (among included header files in at
the top of the program)
-> find in it efm32gg990f1024.h + F3
->find in it core_cm3.h + F3
NVIC functions are needed

" |n core cm3.C search for

#H No Adapters OUt"“e & 24:,@ ‘“brief  Enable Interrupt
E 1% W s @ % || 1499 ‘details Enables a device specific interrupt in the
# NVIC GetVector ~ 1500 ‘“\param [in] IRQgn Device specific interrupt num
# NVIC_USER_IRQ_OFFSET 1501 \note IRQn must not be negative.

L __.'"

__sTarIic_INLINE void|ENZTEEISEte (IROn Type IRQN)

if ((int32 t) (IRQn) >= 0)
{

®F _ NVIC_SetPriorityGrouping{uint32_t) . void
e ° _NVIC_GetPriorityGrouping(void) : uint32_t
@ ® _NVIC_EnablelRQ(IRQn_Type) : void

e _NVIC_GetEnablelRQ(IRQn_Type) : uint22_t
®® _ NVIC_DisablelRQ(IRQn_Type) : void

o ° _NVIC_GetPendingIRQ(IRQn_Type) : uint32_t
®° NVIC SetPending!RQ({IRQn_Type) : void

NVIC->ISER[ (( I{Llil’lt32_t] IRgn) >> 5UL)] = (uint32_t]
}

- Méréstechnika és .
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Interrupt-based character reception

O In core_cma3.c search for
« void _ NVIC EnablelRQ(IRQNn _Type IRQN)

— IRQn_Type IRQn + F3 to check the possible ITs to find:
UARTO _RX_IRQn = 20, /*I< 20 EFM32 UARTO RX Interrupt */

O Code to be applied:

//USERT IntClear (USART TypeDef *usart, uint32 t flags)
USRRT IntClear (UARTO, USART IFC MASK);

//USARRT IntEnable (USART TypeDef *usart, uint32 t flags)

USBERT IntEnable (URRT0, USART IEN RXDATAV);

//woid NVIC EnableIRQ(IRQn Type IRQnN)
__ﬂVIC_EnablEIRQ[HART _RX;IRQn};

/* Infinite loop */
while (1) {
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Interrupt-based character reception

" Core-related IT—IT flags has to be cleared

0 em_decive.h + F3 (among included header files in at
the top of the program)
-> find in it efm32gg990f1024.h + F3
->find in it core_cm3.h + F3
NVIC functions are needed

" |n core_cm3.c search for

i No Adapters g Outline &7 158 \brief Clear Pending Interrupt
E % & e @ ® Y| 1588 ‘details Clears the pending bit of a device specific inter
e ¥ _NVIC_GetPendinglRQ(IRQN_Type) : uint32_t A 1585 \param [in] IEQn Device specific interrupt number.
® ° _NVIC_SetPendingIRQ(IRQN_Type) : void 1550 \note IRQn must not be negative.

%/
__ STATIC INLINE veoid AN Tk 4D LR dcle (TRON Type IRQnN) §

e ® _NVIC_ClearPendingIRQ(IRQn_Type) : void
e ® _NVIC_GetActive(IRQn_Type) : uint32_t

e ¥ _NVIC_SetPriority(IRQn_Type, uint32_t) : void

® ® _ NVIC_GetPriority(IRQn_Type) : uint32_t
o8 MNVIC_EncodePriority(uint32_t, uint32_t, uint32_1) : ui
o8 NVIC_DecodePriority{uint32_t, uint32_t, uint32_t* co
e _NVIC_SetVector(IRQn_Type, uint32_t) : void

if ((int32 t) (IRQn) >= 0)
{
NVIC->ICPR[(((uint32 t)IRQn) >> 5UL)] = (uint32 t) (1UL <

}

}
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Interrupt-based character reception

O In core_cma3.c search for
« void _ NVIC ClearPendinglRQ(IRQN _Type IRQN)

— IRQn_Type IRQn + F3 to check the possible ITs to find:
UARTO_RX_IRQn = 20, /*I< 20 EFM32 UARTO RX Interrupt */

O Code to be applied:

( //USERT IntClear (USART TypeDef *usart, uint32 t flags) N
USART IntClear (URRT0, USART IFC MASK);
- - -7 UART Perif. IT
//USERT TntEnable (USERT TypeDef *usart, uint32 t flags) || clear and enable
\ USERT_IntEnable (UARTO, USELRT_IEH_RXDELTA?]; y
VoI UG ClEarre - ™
l ~ NVIC | ClearPendlngIRQEUARTf] RX IRQH}
Proc. core IT
//woid  NVIC EnableIRQ(IRQn Type IRQn) clear and enable
NVIC EnablEIRQ[UARTD RX IRQI]]I
.~ _ J
/* Infinite loop */
while (1) {
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Interrupt-based character reception

" |Ts have just been correctly configured
O When a character is received at UARTO, IT is generated

" |T function has to be implemented
0 What should happen when IT event occurs
O Check startup_gcc_efm32gg.s in Project Explorer

[ Project Explorer 3| = 5% ¥ = O ||[d *UART_COM.c | em_deviceh | efm32gg990f1.. Ll em_usartc | efm32gg_usarth

% STK3700 blink [GNU ARM v7.2.1 - Dg|| 103 .long I2C1 IRQHandler J* 10 — I2C1 */
5 STK3700 button [GNU ARM v7.2.1 -0l 104 .long GPIO ODD IRQHandler f*11 - GPIO ODD * /
—_— L = u'll'-‘\.' - _ mT E 1 lln'
& UART_COM [GNU ARM v7.2.1 - Debuf| 10° 'i‘mg Eﬁgié—iigiangier . if ‘:Ei‘é !
i i 1le .long andaler Jx 3 — TI 2 *y
v 5 GNU ARM - — _ - _
Uf"{_r-CQM-DEVE'Opme”t-“”' M| 107 .long TIMER3 IRQHandler /* 14 — TIMER3 */
. Binaries 108 .long USART1 RX IRQHandler /* 15 - USART1 RX */
k! Includes 109 .long USART1 TX IRQHandler /* 16 - USRRT1 TX */
~ = CMSIS 110 .long LESENSE IRQHandler /* 17 - LESENSE */
v = EFM32GG 111 .long USART2 RX IRQHandler /* 18 — USRRT2 RX */
S startup_gcc_efm32gg.s 112 -long . /* 19 - USARTZ TX */
[ systemn efm32a0.c ' 113 .long URRET0 EX IRQHandler f/* 20 - UBRRTOD RX */
o ystem-£imseag. 114 .long DRRTO TX IRORandler /* 21 - UARTO TX */
& emli 115 .lona UART1 RX IROHandler /* 22 - UBRT1 RX */
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Interrupt-based character reception

O Check startup_gcc_efm32gg.s in Project Explorer
O Search for UARTO_RX_IRQHandler:

[ Project Explorer 2| = & ¥ = O | [d *UART_COM.c | em_deviceh |l efm32gg990fi.. Ll em_usartc | efm32gg_usarth
(=5 STK3700_blink [GNU ARM v7.2.1 - Dg|| 103 .long I2C1 IRQHandler J* 10 - 1201 */
&5 STK2700 button [GNU ABM v7.2.1 -0 104 .long GPIO ODD IRQHandler f* 11 - GPIO ODD * /!
— L . - Sk . mT ’ i/
& UART_COM [GNU ARM v7.2.1 - Debuf| 197 'i"“‘g EEE%ESEMEH . if ‘:Eié '
: . 106 .long andler /* 13 - TIMERZ2 *,
v 5 GNUARM| -2 — _ - _
UfF‘r_r-CQM-DEVE'Opme”t-“”' | 107 .long TIMER3 IRQHandler /* 14 - TIMER3 */
% Binaries 108 .long USAERT1 RX IRQHandler /* 15 - USRRT1 RX */
k! Includes 109 .long USART1 TX IRQHandler /* 16 - USRRT1 TX */
~ (= CMSIS 110 .long LESENSE_IRQHandler /* 17 - LESENSE */
v (= EFM32GG 111 .long USART2 RX IRQHandler /* 18 - USART2 RX */
S| startup_gcc_efm32gg.s 112 -long AL o DX IBOHSDNG ] ST /* 19 - USRRTZ TX */
B Sygtemm' 113 .long URRTO RX IRQHandler f* 20 - L‘P.R'I‘I_S_RK */
b - ' 114 .long UARTO TX TRQHandler /* 21 - URRTO TX */
= emll 115 .long UART1 RX IROHandler /* 22 - UART1 RX */

0 UARTO_RX IRQHandler is a weak function so |t can be
overdefined in the program without causing any error:

/* Macro to define default handlers. Default handler
* will be weak symbol and just dead loops. They can be
* overwritten by other handlers.
¥ lln'

.macro def irg handler handler name
.weak \handler name
.Set tnandler name, Default Handler - e _
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Interrupt-based character reception

O Implementation of IT function in the program code

0 UART_RX_IRQHandelr function has to be defined
before the main function

e During IT the received data has to be sent to UART

uints t rx data;

O Code to be applied:

'void UARTO RX IRQHandler (void) {

rx data=USART Rx (UARTO);

USART Tx(URRTO, rx data):;

USERT IntClear (UARTO, USART IFC MASK);
}

rint main (void)

{
O Note: no input parameter and no return value
-> void func(void){
what happen during IT;
clear IT flag; }
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Appendix: code —a working version

#include "em device.h"
#include "em chip.h"
#include "em cmu.h"
#include "em gpio.h"
#include "em usart.h"
#include "em core.h"
#include "em emu.h"

-

e B o T W Y O T

fa ]

% uint8 t rx data;
10
1l=woid UVARTO RX IRQHandler (void) {

12 rx_data=USART Rx (UARTO) ;

13 USART Tx (URRTO, rx data);

14 USRRT IntClear (UARTO, USART IFC MASK);
15 1}

16

17=int main (void)

18 {

=
=)

/* Chip errata */
CHIP Init();

B3 B
=

// Enable clock for GPIC
CMU->HFFEECLEEND |= CMU_HFPERCLKEND_GPIG;

| o

[0

// Set PF7 to high
GPIO_ PinModeSet (gpioPortF, 7, gpicModePushPull, 1);

] ]
=1 o LN L D

[0

// Configure UARRTO
// (Now use the "emlib" functions whenever possible.)

..... - aré hnika é .
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Appendix: code —a working version

// Enable clock for URRTD
CMU ClockEnable (cmuClock UARTO, true);

// Initialize UARTO (115200 Baud, 8N1 frame format)

e I R Y S T L T e i

// To 1nitialize the URARTO, we need a structure to hold

// configuration data. It is a good practice to initialize it with
// default wvalues, then set individual parameters only where needed.
USART InitAsync TypeDef UARTO init = USART INITASYNC DEFAULT;

[ ]

[ =S T T T T W I Yy Iy A By W I W

USART InitAsync(URRTO, &UARRTO init);
// USBRTO: see in efm32ggfliz24.h

// Set TX (PEO) and RX (PEl) pins as push-pull cutput and input resp.
// DOUT for T is 1, as it is the idle state for UART communication
GPIO_ PinModeSet (gpioPortE, 0, gpioModePushPull, 1);

// DOUT for RX is 0, as DOUT can enable a glitch filter for inputs,
// and we are fine without such a filter

GPIO_ PinModeSet (gpioPortE, 1, gpioModeInput, 0):

S I N Y S T O T e v TN

[ ]

// Use PEOD as TX and PEl1l as R¥ (Location 1, see datasheet (not refman))
// Enable both R¥X and TX for routing

URRTO->ROUTE |= URRT ROUTE LOCATION LOC 1:
// Select "Location 1" as the routing configuration

URRTO->ROUTE |= URRT ROUTE TXFEN | URRT ROUTE EXPEN;

L T T O O o = ST "y S S S i Y i T

S I N Y S T O T e v TN
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Appendix: code —a working version

2

//USRRT IntClear (USART TypeDef *usart, uint32 t flags)
USERT_IntClear[UERTU, _USERT_IFC_MRSK];

[Fa R

=

//USBERT IntEnable (USART TypeDef *usart, uint32 t flags)

USERT IntEnable (URART(0, USART IEN RXDATAV);

//void  NVIC ClearPendingIRQ(IRQn Type IRQn)
__N?IC_ClearPendingIRQ[UﬂRTQ_RX_IRQﬂ];

//void  NVIC EnableIRQ(IRQn Type IRQn)
__NVIC EnableIRQ(UARTO RX IRQn);

0 =

=] R M T R T Oy oy ey LRGN
L1 S S IO o 1 TR O™ =Sy A ) I

N
=

/* Infinite loop */

. while (1) {

72 //USBRRT StatusGet (USART TypeDef *usart)

13 //1f (USERT StatusGet (UARTO0) & USART STATUS RXDATAV)
14 !/ USART Tx(URRTO, USART Rx (UARTO));

15 !/l ]

16 }

-1
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